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ICD Quick Start Instructions 
A short guide to getting started with the Interactive Conceptual Diagram (ICD) application  

(for more detail, see the complete ICD User Guide) 
 

1. Go to the CADDIS home page (www.epa.gov/caddis), and click on ICD application in the Quick 
Finder to go to the ICD section of the site.  To open the application, click on the Go to ICD 
application link in the Related Links box.   

 
2. If you are not yet a registered ICD user, click Register on the View mode toolbar (see Figure 1) or go 

directly to the EPA Portal (portal.epa.gov
If you do not register, you will be considered a public user:  you will be able to view EPA-constructed diagrams 
(in View mode), but you will not be able to view any other diagrams or access the ICD’s diagram editing & 
collaborating capabilities (in Edit mode). 

).  Remember—you only need to register once! 

a. If you have an EPA LAN account, log in to the portal using your LAN id and password.  
You need to request access to the CADDIS community, so click Community Access >> 
Request Access to Communities, check CADDIS in the list, and click Save Groups. You will 
receive an email when access to the CADDIS community is granted. 

b. If you do not have an EPA LAN account, click the Request Access to EPA Portal link on 
the EPA Portal Log in screen.  Complete the Self-Registration form, using Kate Schofield 
as the EPA Contact Name, schofield.kate@epa.gov as the EPA Contact's Email Address, 
and (703) 347-8533 as the EPA Contact's Phone Number. Under Select the Community 
or Application for which you are requesting access, choose CADDIS, then accept the EPA 
Privacy & Security Notice and click Submit. You will receive an email when access to the 
CADDIS community is granted. 

 
3. Once you have registered, click Log In on the View mode toolbar and log in using your username and 

password.  Once you’ve logged in, you’re ready to get started! 
 
4. To view diagrams (see Figure 1 for a brief description of all options on the View mode toolbar): 

a.   Click the View tab to enter View mode. 

b.   Click Open Diagram, select the diagram you wish to open, and click Open. 
Public users will only be able to view the three EPA-constructed diagrams currently in the 
application; registered users will be able to view these diagrams, any diagrams which they create 
or on which they are designated collaborators, and any diagrams that other creators allow all 
registered users to view. 

c.   Some shapes in the diagram initially may be hidden: a black triangle under a shape 
indicates that there are additional shapes (i.e., child shapes) associated with that shape 
(i.e., the parent shape).  To show all shapes in a diagram, click Show All; to show the 
child shapes under a specific parent, click the black triangle under that parent. 

d.  To search for citations supporting linkages among shapes, click any shape (it will 
highlight blue). 
Shapes linked to the shape you selected by at least one paper currently in the ICD literature 
database will highlight purple.  If a child shape is linked to the shape you selected but hidden, its 
parent shape will be outlined in orange; simply click on the black triangle under that orange-
outlined parent to view any purple-highlighted child shapes.    

e.   Click any purple-highlighted shape (it will highlight blue). 

http://www.epa.gov/caddis�
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Note that the shapes shaded purple change—now, shapes linked to the second shape you 
selected will be highlighted purple. 

f.   If you want to add any additional shapes to your query, click any additional purple 
shapes. 

g.   To deselect any shape you’ve selected, click it again (it will return to its original color). 
h.   To view references supporting linkages among the shapes you’ve selected, click the 

References panel icon     (top right of View mode toolbar). 
The shapes you selected will be listed in the Selected Shapes sub-panel (top); references 
supporting linkages among those shapes will be listed, by shape-pair combination, in the Selected 
Linkages sub-panel (middle). 

i.   If you wish to save any references listed in the Selected Linkages sub-panel, select those 
references by clicking the associated checkboxes, then click Save at the bottom of the 
Selected Linkages sub-panel.  

j.   If you wish to download references from the Saved References sub-panel, select those 
references by clicking the associated checkboxes, then click Download at the bottom of 
the Saved References sub-panel. 

k.   Click Deselect All to clear your search (deselect all shapes) and begin again.   
Any references you saved into the Saved References sub-panel will remain there when you 
Deselect All; they are deleted only when you remove them from the sub-panel or exit your ICD 
session. 

  
 

 
Figure 1.  View mode toolbar in the ICD application. 

 
• Inset icon :  Pan around the open diagram by zooming in and dragging the blue window 

around the Inset (you also can use the Esc key to show/hide the Inset) 
• Open Diagram:  Open a diagram 
• Legend:  View a legend of the shapes used in the EPA-constructed diagrams 
• Collapse/Expand:  Vertically collapse a diagram and remove any unoccupied white space/ 

Vertically expand a diagram and include any unoccupied white space (typically used when child 
shapes are hidden)  

• Hide All/Show All:  Hide all child shapes (shapes designated as sub-categories of another 
shape)/Show all child shapes (view all shapes in diagram) 

• Deselect All:  Reset the shape selection process by deselecting all currently selected shapes 
• View as Image:  View an image of the diagram as it currently appears on the screen 
• Log In/Log Out:  Log in to the ICD application / Log out of the ICD application 
• Register:  Register in the ICD application (only need to do this once; after that, can just log in) 
• Help icon :  Access the ICD User Guide for more detailed help with using the ICDs 
• Search icon :  Conduct a text-based keyword search of references (rather than a diagram-

based search)  
• References Panel icon :  View/Hide the References panel, which shows you selected shapes 

and supporting references for linkages among those shapes 
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5. To create or edit diagrams (see Figure 3  for a brief description of all options on the Edit mode toolbar): 

a. Click the Edit tab to enter Edit mode.   
Remember that the Edit tab will be visible only if you are a registered user logged in to the ICD 
application. 

b. If a diagram is not already open, the Home: Diagram Settings screen (Figure 2) will open 
automatically; if this screen is not open, click Home to bring it up.  
  

 
Figure 2.  Home: Diagram Settings screen, in Edit mode of the ICD application. 

 
i. To create a new diagram (i.e., starting from a blank canvas), click Create New 

Diagram and fill in the required fields. 

ii. To open an existing diagram, browse or search the existing diagrams and select 
the diagram you wish to open (i.e., so that it appears in the Diagram List 
window), then click the Open Diagram icon        . 
As in View mode, registered users will be able to view EPA-constructed diagrams, any 
diagrams which they create or on which they are designated collaborators, and any 
diagrams other creators allow all registered users to view; these will be the options they 
see displayed in the Diagram List window. 

iii. To designate collaborators (i.e., registered users who can make changes to your 
diagram), select the diagram in the Diagram List window, select a user from the 
Registered Users window, and either double-click on or drag-and-drop that user 
to add them to the Collaborators window.  Click the Recategorize Diagram icon  
to save these changes before proceeding. 
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You can only designate collaborators for diagrams you created, and you will only see the 
Recategorize Diagram icon for diagrams you created or on which you are designated as 
a collaborator. 

iv. To change diagram view settings, select the diagram in the Diagram List 
window, check the appropriate boxes next to View Settings (registered users 
will only be able to select the Registered and Check out diagram options), then 
click the Recategorize Diagram icon        . 
You will only see the Recategorize Diagram icon for diagrams you created or on which 
you are designated as a collaborator.  
If you check Registered, all registered users will be able to view and comment on your 
diagram. 
If you check Check out diagram, you will be able to save changes to the existing diagram, 
using the same diagram name—the Save button on the Edit mode toolbar will be 
enabled.  If you designate collaborators on your diagram, remember to select Check out 
diagram each time you’re editing the diagram, to ensure that collaborators are not 
making simultaneous changes to a diagram; when you are done editing, be sure to check 
the diagram back in by unchecking the Check out diagram box and clicking the 
Recategorize Diagram icon.  

v. To change diagram descriptors, select the diagram in the Diagram List window, 
edit the text fields under Diagram Descriptors, then click the Recategorize 
Diagram icon       . 
You will only see the Recategorize Diagram icon for diagrams you created or on which 
you are designated as a collaborator.   

vi. To view all previous versions of a given diagram, select the diagram in the 
Diagram List window and click the Diagram History icon        . 
You will only see the Diagram History icon for diagrams you created or on which you are 
designated as a collaborator.   

vii. To delete a diagram, select the diagram in the Diagram List window and click 
the Delete Diagram icon       . 
You will only see the Delete Diagram icon for diagrams you created or are designated as 
a collaborator.    

    
c.   Once you have created a new or opened an existing diagram, you are ready to start 

building or editing your diagram.   
i. To create your own diagram from an existing one (e.g., the EPA-constructed 

ones), use Save As to save it as a new diagram. 
All information attached to the diagram transfers to your new diagram, including linked 
references. 

ii. To add a shape to the diagram, click on any shape icon on the toolbar, then 
click anywhere on the diagram canvas to place that shape.  Fill in shape 
information in the Shape Attributes screen:  its label (the text which appears in 
the shape), any direction for that label (increasing, decreasing, or change in), 
and any parent designation (the shape that your new shape is a sub-category or 
child of, if any).  
The ability to establish parent-child relationships was created for large, complicated 
diagrams (e.g., the composite EPA diagram) that users may occasionally want to view in 
less detailed form.  This functionality will be evolving in future versions of the ICD, so we 
generally recommend that you do not create any parent-child relationships in your 
own diagrams. 
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iii. To add an arrow or line, click on the arrow or line icon on the toolbar.  Click 
once on the canvas at the point you wish to start the arrow or line to begin 
drawing; click a second time at the point you wish to end the arrow or line to 
stop drawing.   

iv. To delete a shape or line, mouse over the shape or line so that the highlighting 
dots appear, then press the Delete key.  

v. To link supporting references to your diagram, click on Add Linkage, select the 
shapes you want to create a linkage between, then click Save Linkage. 
You can select more than two shapes, but you will have to specify if you want to link the 
first shape you selected to all subsequent shapes (all primary shape pairs), or create links 
between all shape-pair combinations of the selected shapes (all linkage pairs). 

vi. Fill in the required information on the Save New Linkage screen.  You can 
search citations already entered in the ICD literature database using the Find 
Citation field, as well as add new citations individually (click Enter new citation) 
or by uploading references from your reference manager software (click Upload 
new citation(s)).  To select a citation, either double-click it in the Existing 
Citation window, or drag-and-drop it into the Selected Citations window.  Click 
Save to save the linkage. 

vii. To save changes you’ve made to the diagram, either click Save (if you are the 
diagram creator or a designated collaborator) or Save As (to save the diagram as 
a new diagram, with you as the creator).   
If you are the creator or a collaborator and Save is disabled (i.e., shaded out on the 
toolbar), make sure that you have checked the Check out diagram box under View 
Settings and clicked the Recategorize Diagram icon (see above). 

 

 
Figure 3.  Edit mode toolbar in the ICD application. 

 
• Inset icon :  Pan around the open diagram by zooming in and dragging the blue window 

around the Inset (you also can use the Esc key to show/hide the Inset) 
• Home:  Open the Home: Diagram Settings screen, from which you can create a new diagram, 

search for and open an existing diagram, and designate collaborators or modify other diagram 
settings for diagrams you create  

• Save:  Save any changes made to the open diagram 
• Save As:  Save the open diagram as a new diagram  
• Close:  Close the open diagram 
• Shape, Arrow and Line icons:  Add a shape, arrow or line to the open diagram 
• Hide/Show:  Hide/Show all arrows and lines 
• Tiers:  Designate tiers (horizontal layers) of the diagram as collapsible or non-collapsible 
• Select/End:  Select multiple shapes (e.g., to move or delete them)/End the Select function 
• Copy/End:  Copy a shape and all its attributes, for pasting into the open diagram/End the Copy 

function 
• Align/End:  Select and vertically align multiple shapes/End the Align function 
• Add Linkage/Save Linkage:  Link a supporting reference to pair-wise linkages between shapes 
• Comment icon :  Submit a comment on the open diagram 
• Help icon :  Access the ICD User Guide 


